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3a ga moxe Ja ja kopuctuTe annukauujata, noTpebHo e ga ro nogecute pop-up blocker-ot Ha
npebapysa4yoT. Bo oBa ynatcTtBo ce ondateHun npebapysaunte Google Chrome, Mozilla Firefox
n Internet Explorer.

1. NMopecyBamwe Ha Pop-up Blocker Bo Google Chrome’

KnukHeTe Ha Customize and control Google Chrome BO ropHMOT 4eceH aron Ha Npo30peLoT.

[ Customize and control Google Chrome ]

OAa MeHnTO Koe ce oTBOpa M3bupeTe Settings.

New tab Ctrl+T

New window Ctri+N

New incognito window  Cirl+Shift+N

Bookmarks »
Edit Cut | Copy Paste
Zoom - 100% + .
Save page as... Ctrl+S
Find... Ctrl+F
Print... Ctrl+P
Tools >
History Ctri+H
Downloads Ctrl+J

Sign in to Chrome...

Al out Google Chrome

Help
Exit

! OnuwaHa e nocrankara co Bep3|/|jaTa akKTnBHa BO BpPEMETO Kora e I'IVILIJYBaHO/pa3BI/IBaHO ynaTtcTBoTO



Bo HOBMOT npo3opeL, koj ce OTBapa OA4 MEHUTO ABWXKETE Ce HaJosMy CO NOMOLL Ha nn3radkaTa
neHTa u KnNukHete Ha nuHkoT Show advanced settings...

s T e R O T
& - C f | [ chrome//settings w =
Chrome Settings
History On startup
Extensions Open the New Tab page
I Settings () Continue where I left off Fa

® Open a specific page or set of pages. Set pages
Help
Appearance

Get themes || Reset to default theme
[ Show Home button

Change

[Z) Always show the bookmarks bar

Search

Set which search engine is used when searching from the omnibox.

‘ Google ¥ || Manage search engines... J

[J Enable Instant for faster searching (omnibox input may be logged)

Users

You are currently the only Google Chrome user.

Add new user } i Delete this user ‘ ‘ Import bookmarks and settings...

Default browser

The default browser is currently Google Chrome.

Show advanced settings...

MpogorkeTe ga ce OBWXMTE HAZomy CO MOMOLU Ha fiM3radkaTa feHTa godeka He Jojaete o
aenot Privacy, kage wTto Tpeba ga knukHeTe Ha konyeTo Content settings...

( Privacy
@tent setting@ | | Clear browsing data...

Google Chrome may use web services to improve your browsing experience. You may opticnally disable these

services, Learn more

(¥ Use a web service to help resolve navigation errors

(@ Use a prediction service to help complete searches and URLs typed in the address bar
[ Predict network actions to improve page load performance

[#| Enable phishing and malware protection

[} Use a web service to help resolve spelling errors

[] Automatically send usage statistics and crash reports to Google

[] Send a 'Do Not Track' request with your browsing traffic




Bo Content settings... ABMXxeTe ce co nomoLl Ha NU3raykara fieHTa Hagony Ao aenot Pop-
ups Kage wTo Tpeba Aa knukHeTe Ha konvyeto Manage exceptions...

' Allow all sites to show pop-ups

® Do not allow any site to show pop-ups (recommended)

| Manage excePftions... \

Bo genot Hostname Pattern Ha npo3opeuoT Koj ce oTBOpa, Tpeba aa ja goganeTe agpecarta
Ha cTpaHaTa Ha e-[aHouu https://etax-fl.ujp.gov.mk/.

OTKaKoO Ke ja BHeceTe agpecara BO NOJieTo 3a TEKCT KIIMKHeTe Ha konyeTto OK. (Cnuka 6)

Pop-up exceptions *

Hostname pattern

[bitps://etex-fluip.aov.mk

Behavior

Allow i

Learn more

Co oBaa nocTarka ro 3aspliyBaTe noTpebHoTO nogecyBarwe Ha Google Chrome, n moxete aa
ja KopucTute annukauwvjara.


https://etax-fl.ujp.gov.mk/

2. NopecyBawe Ha Pop-up Blocker Bo Mozilla Firefox

3a ga ja kopuctute annukaumjata e-HdaHoun co Mozilla Firefox, noTpebHo e ga nmate Hekoja
of noHosuTe Bep3um (8, 9, 10 unu nosmcoka).

3a pa nposepute koja Bepaunja Ha Mozilla Firefox ja kopuctuTte knukHeTe Ha konyeTo Firefox
Koe ce Haora BO ropHuot neB aron. Og MeHUTo koe ke ce nojaBu nsbepete ja onuujata Help u
Ha Kpaj nsbepete About Firefox. [lokonky onepaTtMBHMOT cucTem Ha koj pabotute e Windows
XP, n3bepete ro Help meHnto n og ncroto nsbepete About Firefox.

.=y

Firefox ¥ oo x | {7} New Tab

[

3 » 7 Bookmarks * R S
8% Start Private Browsing History B
Edit : > Downloads
Find... * Add-ons
Save Page As... Optien <
Email Link... ¢ > Help 5
&=, Print... 4 Getting Started
Web Developer > Troubleshooting Information
Submit Feedback...
Full Screen
Set Up Sync Restart with Add-ons Disabled...
Exit About Firefox
| Lare s ™ v e | v rr Y\ e~ [ v 11 | B R W 4

Bep3uja Ha npebapyBayoT

About Mozl THEia:

Firefox is up to date

N

You are currently on the release update channel.

Firefox is designed by Mozilla, a global community
working together to keep the Web open, public and
accessible to all.

Sound interesting? Get involved!

Licensing Information End-User Rights Privacy Policy

3a Bepanjata 3.5.10 ytBpAEHM ce npobnemu co PYHKUMOHMPaHEeTO Ha annukauvjata u He ce
npenopayvysa Aa ce KopucTu 3a paboTta co annukaumjaTa.



3a pa ro nogecute Pop-up blocker-oT 3anoyHeTe coO kNukKHyBawe Ha kon4yeTto Firefox. Bo

MEHMUTO Koe Ke ce OTBOpW KNnkHeTe Ha Options n noBTOpHO n3bepeTte Options.

ab ﬁ? Bockmarks

x [ 3 New Tab

/7oldversion=18.0,1

[¥¥ Start Private Browsing History

Downloads

Edit
Find...
Save Page As...

Email Link...

&= Print...
Web Developer

Full Screen
Set Up Sync...

Menu Bar

Navigation Toolbar
Bookmarks Toolbar
Add-on Bar  Cirl+/

Toolbar Layout...

B Edit

! | I--AJ-

Op KaTeropmmnTte Kou ke ce npukaxkaT BO roOpHMOT Aen Ha Npo3opeLoT, KnnkHeTe Ha Content.

Options (eS|
‘, ;FA g ] (l ,’g r,:‘,’.' s
0 v 3 Q O
General Ta Privacy Security  Sync  Advanced
Startup

When Firefox starts: [ Show my home page

z)

Don't load tabs until selected

Home Page:

Use
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urrent Page ] { Use Bookmark... ] [ Restore to Default

Downloads
[¥] Show the Downloads window when downloading a file

["] Close it when all downloads are finished

© Savefilesto  jg Downloads

() Always ask me where to save files

Add-ons
Change options for your add-ons

Browse...

0K

] |

Cancel ][ Help ]




Bo Ttabot Ha Content knukHeTe Ha konyeTo Exceptions... koe ce ogHecyBa Ha Block pop-up
windows.

Options u

O & & &8 Q &

General ~ Tabs = Content Applications Privacy  Security  Sync Advanced

«—

Enable JavaScript

Block pop-up windows

Load images automatically

Fonts 8 Colors
Default font: | Times New Roman vl Size: llﬁ vl lﬂdvanced... l

|
Languages |

Choose your preferred language for displaying pages

o] (o ] [t ]

Mpw LITO ce OTBapa Npo3opeL BO KOj MOXeTe Aa AoAasaTe agpech.

Options R |
U 5 el — = —
General  Tabs | Conf] @ AllowedSites-Pop-ups il 8 =N

You can specify which websites are allowed to open pop-up windows. Type

Block pop-up windows the exact address of the site you want to allow and then click Allow.

Load images automatiq | Address of website:
Enable JavaScript IS >

Allow

Fonts & Colors

Default font: | Times New]| Site Status

Languages

Choose your preferred lang)

[ Remove Site ] [ Remove All Sites l




Bo noneto Address of website BHeceTe ja agpecaTta Ha cTpaHaTa Ha e-[aHouwn https://etax-
fl.ujp.gov.mk/ n knukHeTe Ha KonyeTo Allow.

g B

@ Allowed Sites - Pop-ups =R R

You can specify which websites are allowed to open pop-up windows. Type
the exact address of the site you want to allow and then click Allow.

Address of website:

https://etax-fl.ujp.gov.mk/ )

Site Status

)

e ——

Remove Site Remove All Sites "

Co oBaa nocrtanka ro 3aBplyBate noTpebHoTo nogecyBawe Ha Mozilla Firefox, n moxete ga
ja kopuctute annukaumjara.

3. NopecyBawe Ha Pop-up Blocker Bo Internet Explorer 8

[okonky kopuctuTe nomana Bepaunja Ha npebapysayoT Internet Explorer, npenopayyBame aa
ja HagrpaguTe Bep3ujaTta Ha IE 8, nped Aa NoYHeTe CO OCTaHaTUTE YeKopwu onuiaHu noaony.

3a pa npoBepuTe Koja Bep3uja Ha Internet Explorer ja kopuctuTe, ogete BO genot Tools , Koj ce
Haora BO FOPHMOT AEeCeH aron u og MeHuTo u3bepete About Internet Explorer.


https://etax-fl.ujp.gov.mk/
https://etax-fl.ujp.gov.mk/

AL D) > Tools

Print k
File »
Zoom (100%5) LS
Safety 2
View downloads Ctrl+]

Manage add-ons
F12 developer tools

Go to pinned sites

Internet options

About Internet Explorer
@ About Internet Explorer

Windows:* Internet

Versiork 8.0.8112,16421
Update Versions: 9.0. 13 (KB2792100)

Cipher Strength: 256-bit
Product ID: 03553-997-8992662-00010

> Bepsuja Ha npebapyBayoT

Warning: This computer program is protected by copyright law and
international treaties. Unauthorized reproduction or distribution of
this program, or any portion of it, may result in severe civil and
criminal penalties, and will be prosecuted to the maximum extent
possible under the law.

© 2011 Microsoft Corporation

3a pa ro nogecute Pop-up blocker-oT 3anoyHeTe co kNUkHyBawe Ha TOOIS, M 04 MEHWUTO Koe
ce oTBopa n3bupete Internet Options.

Bo npo3sopeuoT Ha Internet Options nsbepete ro Tabot Privacy, nsbepete ja onumjata Turn
on Pop-up Blocker u knukHeTe Ha konyeTo Settings.



| Internet Options 2]

| General | seaurity | Privacy | dontent | Connections | Programs | Advanced |
N~—_—

Settings
Select a setting for the Internet zone.
Medium

- Blocks third-party cookies that do not have a compact
privacy policy
- Blocks third-party cookies that save information that can
3 be used to contact you without your explicit consent
E - Restricts first-party cookies that save information that
T y can be used to contact you without your implicit consent

[ Sites ] [ Import ] [ Advanced ] l Default J

Location
1 Never allow websites to request your

5 o Clear Sites

op-up Blocker
Turn on Pop-up Blocker

—_———

InPrivate

Disable toolbars and extensions when InPrivate Browsing starts

Bo nposopeuoT Ha Pop-up Blocker Settings Bo TekcTtyanHoto norne Address of website to
allow BHeceTe ja agpecaTa Ha cTpaHata Ha e-[aHouwn https://etax-fl.ujp.gov.mk/. u npBo
knukHeTe Ha Add, a noToa Ha kon4yeTto Close.
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https://etax-fl.ujp.gov.mk/

Pop-up Blocker Settings

Exceptions

Pop-ups are cumently blocked. You can allow pop-ups from specific
2 'l webstes by adding the site to the list below.

Mwu.v :
https://etax-fl ujp.gov.mk/ J

Allowed sites:

Notifications and blocking level:
Play a sound when a pop-up is blocked
[¥] Show Notification bar when a pop-up is blocked.
Blocking level:
[Medium: Block most automatic pop-ups v ]

Leam more about Pop-up Blocker Close

Ha kpaj knukHeTe Ha konyeTo OK, 3a Aa ce 3adyBaaT HanpaBeHUTE NPOMEHN.

Co popaBawmeTO Ha agpecaTa Ha CTpaHaTta 3aBpluyBaaT nofecyBawarta 3a npebapysavoTt
Internet Explorer 8 u MmoxeTe Aa ja KOpUCTUTE annukaumjaTa.

Hokonky kopuctute Internet Explorer 9 ctpaHata Ha YJI1 moxeTe ga ja Kopuctute BO

Compatibility View co knukHyBare Ha konyeTo &

— N\
P(\ )| @ nttps/etax-fl.ujp.gov.mk/ £~ @ Ministerstvo Za Finansit.| 8 P X | () 77 €5
T ]
@ ujp.gov.mk » l—.l \rCompatibiIity View: websites designed for older browsers will often look better,
| and problems such as out-of-place menus, images, or text will be corrected.
'E

4. UHcTanunpare Ha Java

11



3a npaBunHa paboTa Ha annukauuwjata noTpebHo e Aa umaTte uHcTanupaHo Java. [okornky
HemaTe UHCTanupaHo, Toa MOXe [la ro HanpaBuUTe Ha CNegHNOT HauuH:

HajnpBo BO MHTepHET npebapyBadoT BHeceTe ja agpecaTa http://www.java.com/en/

Bo cTpaHaTa koja ke ce 0TBOpM KIMKHETe Ha KonyeTo Free Java Download.

L C' O wwwjava.com/en/

Java in Action Downloads

JAVA+YOU,
DOWNLOAD
TODAY!

Free Java Download

Ha ctpaHaTa koja ke ce oTBOpM KNMKHETE Ha konyeTo Agree and Start Free download (Cnuka
21) co WTO ce CuMMHyBa pJaToTeka 3a WHcTanauuwja. 3a paboTta co annukauujata ce
npenopavysa Bep3ujata Java 6.

€« C' | ® www.java.com/en/download/chrome.jsp?locale=en

¢
= Java

Javain Action  Downloads  Help Center

ST E s Download Java for Windows
» Downloading a file in
Chrome

= Google Chrome Hel

Recommended Version 6 Update 30 (filesize: ~ 11 MB})
‘ Agree and Start Free ’
Download

By downloading Java you acknowledge that you have read and accepted the terms of the end user
license agreement

Help Resources

= What is Java?

» Ermor Messages
» Remove Older Versions

= Other Hel

- Mot the right operating system? See all Java downloads here.
ava

= Looking for Java 77 = Downloading a file in Chrome

» System Reqguirements

MoToa co ABOEH KNUK Ha CMMHaTaTa gaTtoTeka NpoaorhkyBaTe co MHCTanauvja Ha Java.
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http://www.java.com/en/

Hokonky nmarte npobnem npu npes3emare Ha HOBa Bep3uja Ha Java java7ub5l, Tpeba ga m
npeB3eMeTe 4YekopuTe dadeHn Ha cnvkuTe BO npogormkeHue. Ogete Ha Settings->Control

Panel:

L Programs 4

=y }} Documents »

Control Panel

Professional

= & Network Connections
,.) Search ’ ,fJ s
<@ Printers and Faxes
gl Taskbar and Start Menu

= @) Help and Support

Run...

=
m Shut Down...

KrnnkHeTe Ha Java:

s @ v s

Display Flash Player Folder Options Fonts

e

A

=l(R) GMA Internet Java Jinitiator
Driver Options 1.3.1.17
Q L @ ©
=) @v =
letwork Phone and Power Options  Printers and
nnections Modem ... Faxes

Ke Bu ce nojaeu nposopel Ha koj Tpeba aa rm usbeperte crneaHMBE Hekopu:

13



e R D]

W

General | Update | Java| Security | Advanced |

Enable Java contentin ‘h’T browser

Security Level

(1 Ver‘/ H'gh

LE
Applications launched from the sites listed below will be allowed to run after the appropriate security
prompts.

[ 1> High (minimum recommended) 2 Location 5
(| sl govrid | ]
E ]
Medium

Java applications identified by a certificate from a trusted authority will be allowed to run.

Exception Site List
Applications launched from the sites listed below will be allowed to run after the appropriate
security prompts. “lg FILE and HTTP protocols are considered a security risk.
https://etax-fl.uip.gov.mk/ P 3 We recommend using HTTPS sites where available.
3 | Edit Site List...

[ Restore Security Prompts ][ Manage Certificates... ]

5. UHcTanupamwe Ha gurutaneH ceptudpumkar

Mpen oa ro nHctanupaTte copTBEPOT 3a TOKEHOT, NOTPebHO € Aa npoBepuTe Aanu MalluHaTta
Ha Koja ke pabotute e 32 OGuTHa unn 64 GuTHa MawwmHa. VICTOToO MOXe ga ro HanpasuTe Co
nomMoLl Ha cnegHWMoOT 4ekop: Start-> Programs-> Accessories-> System Tools-> System
Information. Ha npo3opeLoT Koj ke ce oTBopu BO AenoT System Type ce Haorfa notpebHaTa

nHdopmaumja.

B spemiomaton g [y W ey

A GSEEpe—.

PLge T— a

File Edit View Help

System Summary TItem

- Hardware Resources 0OS Name
(- Components Version
Software Environment Other OS Description

0S Manufacturer
System Name
System Manufacturer
System Model

Value

Microsoft Windows 7 Enterprise
6.1.7601 Service Pack 1 Build 7601
Not Available

Microsoft Corporation
VIKTORUA-STOJK

To Be Filled By O.E.M.

To Be Filled By O.EM.
X86-based PC

Boot Device

Locale

Hardware Abstraction Layer
User Name

Time Zone

Installed Physical Memory (RAM)
Total Physical Memory
Available Physical Memory
Total Virtual Memory
Available Virtual Memory
Page File Space

Page File

<[ System Type
Processor Pentium(R) Dual-Core CPU E5700 @ 3.00GHz, 3000 Mhz, 2 Core(s), 2 Log...
BIOS Version/Date American Megatrends Inc. 080015, 1/13/2010
SMBIOS Version 25
Windows Directory C:\Windows
System Directory C:\Windows\system32

\Device\HarddiskVolumel
United States

Version = "6.1.7601.17514"
ASSECOSEEMK\viktorija.stojkovic
Central European Standard Time
400 GB

297 GB

263 MB

593 GB

143 GB

297 GB

C:\pagefile.sys

14



BpeaHocTa koja ja nma genot System Type kaxyBa ganu kopuctute 32-6utHa unm 64-6utHa
MaLLWHa, Ha CNEeAHVNOB HaYMH:

e Xx86-based PC: 32- butHa malumHa
e Xx64-based PC: 64- butHa malumHa

[okonky kopuctute 64 GMTHaA MallMHa, NPU MHCTanaumja Ha codTBEp 3a TOKEHOT Ha KOj ce
Haora guruTanHMoT cepTudukar, NoTpedbHO € NCTUOT Aa ce MHCTanupa AnpekTHo Bo C:, a He BO
Program files. MNpumep C:\gemalto

Hokonky umate SafeNet TokeH, nokpaj apajsepute Kom Tpeba aa rm MHcTanupaTte 3a TOKEHOT,
Tpeba pa ja wHCTanuMpate W annukaumjata AgocTtanHa Ha  CNegHuMoT  JIMHK
https://webconnector.mt.net.mk/SNAplikacija/SafeNet Borderless Security.msi.

3a npaBunHa paboTa co TOKEHOT npenopayvyBame Aa umaTe MHCTanupaHo coTeep 1 apajsepu
camMO 3a efeH TOKeH nopagu MOXHM npobnemMyn Kou HacTaHyBaaT BO MPUCYCTBO Ha
WMHCTanuMpaHu gpajsepu 3a Asa unm noBeke TOKEHW.

6. NMpob6nemun co npumarwse Ha maun ox E-paHoum (camo 3a mann agpecu
oA aomeHuTte hotmail, outlook m live)

MocTomn BepojaTHOCT Aa Bu ce cnyun ga He npumute mMaun 3a M3BeCTyBawe of cuctemot E-
AaHOUM BO YCIOBM KOra MCTUOT ucnpaka ronem 6poj Ha e-maun nopakm KOH KOPUCHULW KOU
nmaaT Maun agpeca Of ropeHaBefeHuTe gomeHw. [lopagn oBue npuumHu Tpeba pa ce
HajaBuTe Ha BawwuoT mann n ga ja usbepete onunjata More mail settings , koja ce Haofa BO
rOPHUOT AeceH aron o BawwnoT npebapysau.

¥ &= outlook - =

Reading pane
Off
® Right

Bottom

Help

Feedback

15


https://webconnector.mt.net.mk/SNAplikacija/SafeNet_Borderless_Security.msi

MoToa ogeTte BO genot Preventing junk email n knukHeTe Ha Safe and blocked senders.

Eﬁ Outlook | v~

OptioNs  inbox > Options

Managing your account Preventing junk email

Account details (password. addresses. time zone) Filters and reporting

Your email accounts Safe and blocked sendeD

Email forwarding

Customizing Outlook

Sending automated vacation replies

POP and deleting downloaded messages Advancedipavacy.setings

Create an Outlook alias Language

Rename your email address Keyboard:shortcuts

Upgrade to Ad-free Outlook Rules for sorting new messages
Flagging

Writing email Instant actions

Formatting. font and signature

Reply-to address

Saving sent messages

Attachments

Reading email

Reading pane

Active view settings

Group by conversation and pre-load messages
Content from third-party networks

Default view after moving or deleting email

Reply Settings

N36epeTe Safe senders.
Safe and bIOCked Seﬂders Inbox » Options » Safe and blocked senders

Manage who is allowed to send you email. Messages from safe senders will not be sent to the junk email folder.

Safe mailing lists

Manage which mailing lists are sent to your account. Messages to safe mailing lists will not be sent to the junk email folder.

Blocked senders

Manage who is blocked from sending you email. Messages from blocked senders are automatically deleted.

Bo noneto Sender or domain to mark as safe BHeceTe etax@ujp.gov.mk 1 knukHeTe Ha Add

to list>>.

16
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Sﬁfe Sefders Inbox » Options » Safe and blocked senders » Safe senders

Messages from safe senders will not be sent to the junk email folder, You can mark specific email addresses as safe or mark a whole domain (the part of an email address after the @ sign).

To allow an email address or domain into your inbox, enter it in the box below, and then dlick Add te list. To remove an address or domain, select it in the list below, and then click Remove from list.

Sender or domain to mark as safe: Safe senders and domains:
etax@ujp.gov.mk Add to list >>
Example: name@example.com << Remove from list

Emann agpecaTta etax@ujp.gov.mk Tpeba ga ce nojasm Bo genot Safe senders and domains.

Safe senders  mmbox » Options » Safe and blocked senders » Safe senders

Messages from safe senders will not be sent to the junk email folder. You can mark specific email addresses as safe or mark a whole domain (the part of an email address after the @ sign).

To allow an email address or domain into your inbox, enter it in the box below, and then click Add to list. To remove an address or domain, select it in the list below, and then click Remove from list.

Sender or domain to mark as safe: Safe senders and domains:

Add to list >> etax@ujp.gov.mk

Example: name@example.com << Remove from list

7. Mpobnemun co npumarwse Ha maun ox E-paHoum (camo 3a mann agpecu
oA AoMeHOoT yahoo.com)

MocTon BepojaTHOCT Aa Bu ce cnyun ga He npumuTe Maun 3a U3BecTyBawe 0f cucTtemoT E-
AaHoUM 1nv ga npMMuTe Maun co 3af0LHyBake BO YCIIOBM KOra UCTUOT ucnpaka ronem 6poj Ha
€-Maurn nopakmM KOH KOPUCHMLM Ko nMaaT Maun agpeca og AoMeHoT yahoo.com. MNopagu osue
npuymHun Tpeba aa ce HajaBuTe Ha BawwmoT mann 1 ga rm Hanpaeute crnegHUBE NodecyBakba BO
aenot Settings, Koj ce Haora Bo ropHMOT aeceH aron oA Bawwnot npebapysau.
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o

Help

Themes

< Settings 3
=

Ad Free Mail

Privacy
Terms
About our Ads

Account Info

N36epeTe npeo Filters, na knukHeTe Ha kon4yeTo Add.

Settings
Accounts
- . Sort incoming messages into
Viewing email folders
Writing email

Vacation Response

Security
Blocked Addresses

Messenger

T T Y

Mpwn wTo ke Bu ce nojaBu cnegHMOT nposopeL;:
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Filter Name:

If all of the following Sender Match case ||
rules are true... Contains v@gov.@
Recipient Match case [7]
Contains v
Subject Match case [
Contains v
Email body Match case [
Contains v
Then deliver the emall Inbox v

to the following folder

Bo noneto Filter Name BHeceTe ujp, gogeka Bo genot Sender , Bo Match case BHeceTe
*ujp.gov.mk. Ha kpaj knukHeTe Ha KonyeTo Save.
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